ABSTRACT

TPS53679, TPS53659, TPS53622 are Intel™ VR13 Serial VID (SVID)-compliant power supply controllers that have programmable parameters. This guide also applies to proprietary footprint devices TPS53678, TPS53658 TPS53655, as well as TPS53681, even though it is not an Intel power controller. The PMBus interface configures the parameter values which are stored into non-volatile memory (NVM) as new boot-up default values. This guide gives a tutorial on NVM programming, and the tools TI provides for the programming process. This guide applies to all the devices in the TI VR13 controller family.

List of Figures

1 Hardware Connections ................................................................. 5
2 Send Byte Protocol................................................................. 6
3 Write Byte Protocol ............................................................. 6
4 Write Word Protocol ............................................................ 6
5 Read Word Protocol .............................................................. 6
6 Block Write Protocol ............................................................ 6
7 Block Read Protocol ............................................................. 6
8 Change Scanning Modes ........................................................ 9
9 Scanning Mode Selections ....................................................... 9
10 System View ........................................................................ 10
11 Settings for Individual Device ........................................... 11
12 Write to Hardware ............................................................... 11
13 Refresh All Parameters ........................................................ 12
14 Switch between Multiple Devices ........................................ 12
15 Save a System File ............................................................... 13
16 Select System File ............................................................... 14
17 Select Offline System File ................................................... 14
18 Offline System View ............................................................. 15
19 Import to Devcie ................................................................. 16
20 Import Project File .............................................................. 16
21 Select Project File ............................................................... 17
22 Select All and Write Checked Parameters ......................... 18
23 Successful Project File Import .............................................. 19
24 Store to NVM ..................................................................... 19
25 Import System File ............................................................. 20
26 Check All Parameters ........................................................ 21
27 System File Import Messages ............................................ 21
28 Device File Export ............................................................. 22
Introduction

This guide gives an overview of NVM programming for the following TI VR13 controller devices: TPS53679, TPS53659, TPS53622, TPS53678, TPS53658, TPS53655 and TPS53681. Local TI sales and field applications representatives can provide relevant documentation to these devices. This guide gives a technical overview and step-by-step instructions.

List of Tables

1 Configuration File Formats ........................................................................................................... 3
2 Hardware Connections for Offline NVM Programming ................................................................. 4
3 SMBus Transaction Types .............................................................................................................. 5
4 Example NVM Data ....................................................................................................................... 7

Trademarks

Intel is a trademark of Intel Corporation.

1 Introduction

This guide gives an overview of NVM programming for the following TI VR13 controller devices: TPS53679, TPS53659, TPS53622, TPS53678, TPS53658, TPS53655 and TPS53681. Local TI sales and field applications representatives can provide relevant documentation to these devices. This guide gives a technical overview and step-by-step instructions.
1.1 Software Tools

1.1.1 Fusion Digital Power Designer

*Fusion Digital Power Designer* is a graphical user interface (GUI) that configures and monitors Texas Instruments digital power controllers, sequencer monitors, and health monitors. The GUI uses the PMBus protocol to communicate with the device over a serial bus using a proprietary USB adapter.

Use the *Fusion Digital Power Designer* GUI for engineering development. The GUI gives access to all available user-configurable settings, fault information, and telemetry readings. After you configure the device, you can export the settings to a configuration file. The export options are:

- **System** file (.tifsp) contains configuration data for all of the devices in a system
- **Project** file (.xml) contains configuration data for a single device
- PMBus programmer script (.csv) is a text file containing step-by-step programming instructions for non-TI software tools

Download the latest version of *Fusion Digital Power Designer* from this URL: http://www.ti.com/tool/fusion_digital_power_designer

1.1.2 Fusion Manufacturing Tool

The *Fusion Manufacturing Tool* is a graphical user interface (GUI) that programs TI digital power controllers in a production environment. Download the latest copy of the *Fusion Manufacturing Tool* from this URL: http://www.ti.com/tool/fusion_mfr_gui

1.1.3 Online and Offline Modes

The *Fusion Digital Power Designer* software operates in online mode when you have connected a device to the system that hosts the software. The software operates in offline mode when you have not connected a device to the system that hosts the software. The software installer provides a different shortcut for each mode.

1.1.4 Relevant File Formats

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
<th>Extension</th>
<th>Type</th>
<th>Compatible Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fusion project file</td>
<td>Contains configuration data for a single device. Intended for engineering development.</td>
<td>.xml</td>
<td>plain-text XML</td>
<td><em>Fusion Digital Power Designer</em></td>
</tr>
<tr>
<td>Fusion system file</td>
<td>Contains configuration data for multiple devices. Can be used in engineering development, and production programming.</td>
<td>.tifsp</td>
<td>plain-text XML</td>
<td><em>Fusion Digital Power Designer, Fusion Manufacturing Tool</em></td>
</tr>
<tr>
<td>PMBus programmer script</td>
<td>Simplified programming script (comma separated format) for production environment.</td>
<td>.csv</td>
<td>plain-text comma separated value</td>
<td><em>Fusion Digital Power Designer and third-party tools</em></td>
</tr>
</tbody>
</table>

1.2 Hardware Tools

1.2.1 USB-to-GPIO Dongle

Both *Fusion Digital Power Designer* and *Fusion Manufacturing Tool* GUIs use the TI USB-GPIO adapter to interface between a host computer and controller devices. Use this link to get a TI USB-GPIO adapter: http://www.ti.com/tool/usb-to-gpio.
2 Technical Overview

This section shows how to program NVM with the TI software tools, or with non-TI tools.

2.1 Hardware Connections

You can program NVM on a fully-populated application board. However, successful programming requires only a few connections be made to these devices. In some cases offline gang-programming in socketed boards works better than a full In Circuit Test (ICT) solution.

<table>
<thead>
<tr>
<th>Pin Name</th>
<th>Connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>V3P3</td>
<td>Connect to +3.3V supply, and bypass with a minimum of 1.0 µF to ground.</td>
</tr>
<tr>
<td>VREF</td>
<td>Bypass to ground with a minimum of 1.0 µF to ground.</td>
</tr>
<tr>
<td>ADDR</td>
<td>Connect a resistor divider from VREF to ADDR to Ground to set the PMBus address (required for programming), as described in the product datasheet.</td>
</tr>
<tr>
<td>SMB_DIO, SMB_CLK</td>
<td>Connect to programming host, pull-up to 3.3V with a 2.2 kΩ resistor. Note, the TI USB-to-GPIO interface adapter has internal pull-up resistors.</td>
</tr>
<tr>
<td>ATSEN, BTSEN, TSEN</td>
<td>Not used for NVM programming. Tie-off with a 1:1 resistor divider from VREF to TSEN to Ground, suggested resistor value is 49.9 kΩ. This sets the pin voltage to appx. 0.85 V, which the controller device interprets as 32°C.</td>
</tr>
<tr>
<td>AVR_EN, BVR_EN, VIN_CSNIN, CSPIN, AVSP, BVSP, AVSN, BVSN</td>
<td>Not used for NVM programming. Tie-off to ground.</td>
</tr>
<tr>
<td>ACSPx, BCSPx</td>
<td>Not used for NVM programming. Tie-off to VREF.</td>
</tr>
<tr>
<td>APWMx, BPWMx, ASKIP, BSKIP, VRFAULT, SMBALERT, SALERT, PIN_ALT, SDIO, SCLK</td>
<td>Not used for NVM programming. Float these pins if not used.</td>
</tr>
</tbody>
</table>
2.2 Communication Protocol and Interfacing

These devices comply with the PMBus version 1.3 specification. Use this link to find timing and electrical characteristics of the PMBus specification in the PMB Power Management Protocol Specification, Part 1, revision 1.3 available at http://pmbus.org. The PMBus specification inherits its transport and network layer behavior from the SMBus specification. These devices comply with the SMBus 3.0 specification, which is available at this URL: http://smbus.org/specs/. Use the transaction prototypes to program the device NVM correctly. Refer to the Section 2.3 section for more information about prototype use in NVM programming.

The use of Packet Error Correction (PEC) is optional. If clock pulses are supplied for a PEC byte, these devices use PEC, otherwise they do not. For simplicity, Table 3 lists required transaction types without PEC bytes.

Table 3. SMBus Transaction Types

<table>
<thead>
<tr>
<th>Transaction Type</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send Byte</td>
<td>Used to issue NVM Store operations (STORE_DEFAULT_ALL).</td>
</tr>
<tr>
<td>Write Byte</td>
<td>Used to change the current PAGE</td>
</tr>
<tr>
<td>Write Word</td>
<td>Used to Write the value of VOUT_MAX.</td>
</tr>
<tr>
<td>Read Word</td>
<td>Used to Read the current value of VOUT_MAX.</td>
</tr>
<tr>
<td>Write Block</td>
<td>Used to Write the USER_DATA commands, which contain most of the NVM storable parameters these devices support.</td>
</tr>
<tr>
<td>Read Block</td>
<td>Used to read the USER_DATA commands and checksum (MFR_SERIAL).</td>
</tr>
</tbody>
</table>
2.3 Programming Process

To simplify the programming procedure and reduce programming time, TI VR13 controller devices combine NVM settings into a small number of registers. All settings in MFR_SPECIFIC commands map into registers USER_DATA_00 through USER_DATA_12. Only a few other registers are required. Program the USER_DATA command with the Block Read/Write command protocol described in the SMBus Specification. Table 4 lists the complete NVM configuration for a single device. All other settings map to USER_DATA commands.

The Fusion Digital Power Designer GUI lets power supply designers configure devices in a graphical environment. The GUI saves these settings in a configuration file or script that you can load on to other devices.
2.3.1 Programming Procedure

This section describes NVM programming through third-party tools. This procedure is completed automatically during import and export of Project files from Fusion Digital Power Designer.

Configure User-Programmable Parameters (one-time only)

1. Set all of the user-accessible parameters via the standard PMBus, and Manufacturer Specific commands, using Fusion Digital Power Designer or the Technical Reference Manual for the device.
2. Issue the STORE_DEFAULT_ALL command. This command commits these values to NVM, and updates the checksum value.
3. Wait approximately 100 ms.
4. Write PAGE to 00h.
5. Read-back and Record the value of IC_DEVICE_ID and IC_DEVICE_REV commands
6. Read-back and Record the value of the USER_DATA_00 through USER_DATA_12 commands
7. Read-back and Record the value of the MFR_SERIAL command
8. Read-back and Record the value of VOUT_MAX
9. Write PAGE to 01h
10. Read-back and Record the value of VOUT_MAX

Program and Verify NVM (repeat for each device)

1. Apply 3.3 V to the V3P3 pin to start the device. Make sure to disable power conversion for NVM programming.
2. Read-back and verify that IC_DEVICE_ID and IC_DEVICE_REV values match those recorded previously. This verification ensures that user-parameters being programmed correspond to the same device/revision as previously configured.
3. Write PAGE to 00h.
4. Write the USER_DATA_00 through USER_DATA_12 commands, with the values recorded previously.
5. Write VOUT_MAX (Page 0) with the value recorded previously.
6. Write PAGE to 01h
7. Write VOUT_MAX (Page 1) with the value recorded previously.
8. Issue STORE_DEFAULT_ALL.
9. Wait approximately 100 ms.
10. Read-back the MFR_SERIAL command, and compare the value to that recorded previously. If the new MFR_SERIAL matches the value recorded previously, the software has successfully programmed the NVM.

2.3.2 Example NVM Data

Table 4 gives an example configuration that contains all programmable parameters in a VR13 controller device. Every application has different data. All other parameters stored in configuration files are either calculated, measured, or derived from these values. The Fusion Digital Power Designer GUI displays block commands in ascending order of significance (for example byte 0, byte 1, ...). The GUI displays word commands in descending significance (for example byte 1, byte 0).

Table 4. Example NVM Data

<table>
<thead>
<tr>
<th>PMBus Command</th>
<th>Transaction Type</th>
<th>CMD Code (hex)</th>
<th>Example Value (hex)</th>
</tr>
</thead>
<tbody>
<tr>
<td>USER_DATA_00</td>
<td>Block Write, Block Read</td>
<td>B0h</td>
<td>1410020030F5</td>
</tr>
<tr>
<td>USER_DATA_01</td>
<td>Block Write, Block Read</td>
<td>B1h</td>
<td>000000000040</td>
</tr>
<tr>
<td>USER_DATA_02</td>
<td>Block Write, Block Read</td>
<td>B2h</td>
<td>8904000000D0</td>
</tr>
<tr>
<td>USER_DATA_03</td>
<td>Block Write, Block Read</td>
<td>B3h</td>
<td>030010050080</td>
</tr>
<tr>
<td>USER_DATA_04</td>
<td>Block Write, Block Read</td>
<td>B4h</td>
<td>0906C325C777</td>
</tr>
</tbody>
</table>
Use of TI Programming Tools

This section gives short tutorials for common tasks using the **Fusion Digital Power Designer** software.

### 3.1 Fusion Digital Power Designer

**WARNING**

Create *Fusion Digital Power Designer System files* and *Project files* in online mode only. Do not update settings in offline mode. Files that you edit offline will not have the correct USER_DATA and checksum values stored in the *System file*, and can lead to unpredictable results.

#### 3.1.1 Build and Export a System (.tifsp) File

The *Fusion Digital Power Designer* software has a convenient graphical interface to configure and test TI VR13 controllers.

An more detailed discussion of each parameter in the GUI can be found in the application report *Using the Fusion Digital Power Designer for TPS536xx VR13 Multiphase Solutions*. Contact vr@list.ti.com for more information.

1. Connect the USB-GPIO adapter to either a system board, or socketed programming board with a TI VR13 controller on-board.
2. Apply 3.3 V to the V3P3 pins of the controller devices. It is not necessary to apply 5-V and 12-V power. Make sure to disable power conversion. You may need to pull the AVR_EN/BEN pins low to stop power conversion.
4. Click **Change Scanning Modes**, then select **DEVICE_ID & DEVICE_CODE & IC_DEVICE_ID** if the software does not recognize your device.

---

Table 4. Example NVM Data (continued)

<table>
<thead>
<tr>
<th>PMBus Command</th>
<th>Transaction Type</th>
<th>CMD Code (hex)</th>
<th>Example Value (hex)</th>
</tr>
</thead>
<tbody>
<tr>
<td>USER_DATA_05</td>
<td>Block Write, Block Read</td>
<td>B5h</td>
<td>E408C579B3E1</td>
</tr>
<tr>
<td>USER_DATA_06</td>
<td>Block Write, Block Read</td>
<td>B6h</td>
<td>85DA1112E87F</td>
</tr>
<tr>
<td>USER_DATA_07</td>
<td>Block Write, Block Read</td>
<td>B7h</td>
<td>804B051053FA</td>
</tr>
<tr>
<td>USER_DATA_08</td>
<td>Block Write, Block Read</td>
<td>B8h</td>
<td>0000000000A6</td>
</tr>
<tr>
<td>USER_DATA_09</td>
<td>Block Write, Block Read</td>
<td>B9h</td>
<td>000170848080</td>
</tr>
<tr>
<td>USER_DATA_10</td>
<td>Block Write, Block Read</td>
<td>BAh</td>
<td>00262EC0C185</td>
</tr>
<tr>
<td>USER_DATA_11</td>
<td>Block Write, Block Read</td>
<td>BBh</td>
<td>080220C08FE1</td>
</tr>
<tr>
<td>USER_DATA_12</td>
<td>Block Write, Block Read</td>
<td>BCb</td>
<td>40F08D20FF01</td>
</tr>
<tr>
<td>VOUT_MAX[PAGE 0]</td>
<td>Write Word, Read Word</td>
<td>24h</td>
<td>00FF</td>
</tr>
<tr>
<td>VOUT_MAX[PAGE 1]</td>
<td>Write Word, Read Word</td>
<td>24h</td>
<td>00FF</td>
</tr>
<tr>
<td>MFR_SERIAL</td>
<td>Block Write, Block Read</td>
<td>9Eh</td>
<td>05C60AD2</td>
</tr>
</tbody>
</table>
Figure 8. Change Scanning Modes

Figure 9. Scanning Mode Selections
5. From the System View, click **Click to Configure Device** to view individual controller devices.


![Figure 10. System View](image-url)
6. Click on **Write to Hardware** to set the write values to the device.

![Figure 12. Write to Hardware](image)

7. Click **Store Config. to NVM** to store the NVM settings.

8. Click **Device Menu**

9. Click **Refresh All Parameters** to update USER_DATA commands in the GUI.
10. Select **Save Project As** from the **File** menu to export a **Project** file for a single device.

![Configuration TP53622 PMBus Address 95d (60h) / I2C Configuration](image)

**Figure 13. Refresh All Parameters**

11. Repeat steps 5 through 14 for each device.

12. To set NVM values for another device, return to the **System View** page and **Click to Configure Device**.

![Texas Instruments - Fusion Digital Power Designer (System View)](image)

**Figure 14. Switch between Multiple Devices**

13. To save a **System** file after all devices are configured, return to the **System View** click the **File** menu and select, **Save System File As**.
3.1.2 View a Project File or System File Offline

When the software operates in offline mode, you cannot update any NVM settings. Use offline mode only to view System files.

**WARNING**

_Fusion Digital Power Designer offline mode is for viewing of files only. To edit NVM settings, use online mode, which requires a controller device to be connected. System files that users edit offline may not contain the correct USER_DATA and checksum values stored in the System file, and can lead to unpredictable results._

1. Open _Fusion Digital Power Designer_ in offline mode.
2. Select _Create offline system by opening existing system file._
3. Click _Next_
Figure 16. Select System File

4. Browse to the file when prompted, and click Next.

Figure 17. Select Offline System File
5. Click Finish to open the System file to review.

3.1.3 Import a Project File to a Single Online Device

1. Connect the USB-GPIO to a board.
2. Apply 3.3 V to the V3P3 pin of the controller device.
4. From the System View window, Click to configure device
5. From the File menu, select Import to device
6. Select Project File
7. Click Next.
Figure 19. Import to Device

Figure 20. Import Project File
Figure 21. Select Project File

8. Click **Select All** to import all parameters of the device.
9. Click **Write Checked**.
The following table summarizes any differences between the parameters in your project file and the values currently in memory on the device. By default, only modified parameters will be written out. You can choose, however, to skip certain parameters by unchecking its checkbox. When ready, click the "Write" button to write checked parameters to the device.

<table>
<thead>
<tr>
<th>Import</th>
<th>Parameter</th>
<th>Updated</th>
<th>Device Value</th>
<th>Device Hex</th>
<th>New Value</th>
<th>New Hex</th>
</tr>
</thead>
<tbody>
<tr>
<td>DIN_OFF_CONFIG</td>
<td>[0x02, Rail #1]</td>
<td>Yes</td>
<td>Mode: CONTROL</td>
<td>0x17</td>
<td></td>
<td>0x17</td>
</tr>
<tr>
<td>USER_DATA_00</td>
<td>[0x80, Rail #1]</td>
<td>Yes</td>
<td>3329020030F3</td>
<td>0x3329020030F3</td>
<td>3329020030F3</td>
<td>0x3329020030F3</td>
</tr>
<tr>
<td>USER_DATA_01</td>
<td>[0x81, Rail #1]</td>
<td>Yes</td>
<td>000000000040</td>
<td>0x000000000040</td>
<td>000000000040</td>
<td>0x000000000040</td>
</tr>
<tr>
<td>USER_DATA_02</td>
<td>[0x82, Rail #1]</td>
<td>Yes</td>
<td>89000000000D</td>
<td>0x89000000000D</td>
<td>89000000000D</td>
<td>0x89000000000D</td>
</tr>
<tr>
<td>USER_DATA_03</td>
<td>[0x83, Rail #1]</td>
<td>Yes</td>
<td>040000AA080B</td>
<td>0x040000AA080B</td>
<td>040000AA080B</td>
<td>0x040000AA080B</td>
</tr>
<tr>
<td>USER_DATA_04</td>
<td>[0x84, Rail #1]</td>
<td>Yes</td>
<td>A5EC7F7C777</td>
<td>0xA5EC7F7C777</td>
<td>A5EC7F7C777</td>
<td>0xA5EC7F7C777</td>
</tr>
<tr>
<td>USER_DATA_05</td>
<td>[0x85, Rail #1]</td>
<td>Yes</td>
<td>1E32C597F3C</td>
<td>0x1E32C597F3C</td>
<td>1E32C597F3C</td>
<td>0x1E32C597F3C</td>
</tr>
<tr>
<td>USER_DATA_06</td>
<td>[0x86, Rail #1]</td>
<td>Yes</td>
<td>E5DB13104001</td>
<td>0xE5DB13104001</td>
<td>E5DB13104001</td>
<td>0xE5DB13104001</td>
</tr>
<tr>
<td>USER_DATA_07</td>
<td>[0x87, Rail #1]</td>
<td>Yes</td>
<td>80FF05205FFF</td>
<td>0x80FF05205FFF</td>
<td>80FF05205FFF</td>
<td>0x80FF05205FFF</td>
</tr>
<tr>
<td>USER_DATA_08</td>
<td>[0x88, Rail #1]</td>
<td>Yes</td>
<td>0002000300B</td>
<td>0x0002000300B</td>
<td>0002000300B</td>
<td>0x0002000300B</td>
</tr>
<tr>
<td>USER_DATA_09</td>
<td>[0x89, Rail #1]</td>
<td>Yes</td>
<td>0025E083800D</td>
<td>0x0025E083800D</td>
<td>0025E083800D</td>
<td>0x0025E083800D</td>
</tr>
<tr>
<td>USER_DATA_10</td>
<td>[0x8A, Rail #1]</td>
<td>Yes</td>
<td>0A6028C0410D</td>
<td>0xA6028C0410D</td>
<td>0A6028C0410D</td>
<td>0xA6028C0410D</td>
</tr>
<tr>
<td>USER_DATA_11</td>
<td>[0x8B, Rail #1]</td>
<td>Yes</td>
<td>00220000A921</td>
<td>0x00220000A921</td>
<td>00220000A921</td>
<td>0x00220000A921</td>
</tr>
<tr>
<td>USER_DATA_12</td>
<td>[0x8C, Rail #1]</td>
<td>Yes</td>
<td>80901200F801</td>
<td>0x80901200F801</td>
<td>80901200F801</td>
<td>0x80901200F801</td>
</tr>
<tr>
<td>VOUT_COMMAND</td>
<td>[0x21, Rail #1]</td>
<td>Yes</td>
<td>1.000 V</td>
<td>0x000F7</td>
<td>1.000 V</td>
<td>0x000F7</td>
</tr>
<tr>
<td>VOUT_COMMAND</td>
<td>[0x21, Rail #2]</td>
<td>Yes</td>
<td>1.200 V</td>
<td>0x000F7</td>
<td>1.200 V</td>
<td>0x000F7</td>
</tr>
</tbody>
</table>

Figure 22. Select All and Write Checked Parameters
Figure 23. Successful Project File Import

10. When the Project file import finishes, the software does not automatically issue an NVM store operation command. You must click Store Config to NVM to update NVM settings after you import a Project file.

Figure 24. Store to NVM

3.1.4 Import a System File to an Online System

1. Connect the USB-GPIO interface to the board
2. Apply 3.3 V to the V3P3 pins of the controller devices.
4. From File menu on the System View page, select Import System File...

![Image of Fusion Digital Power Designer software interface with Import System File highlighted]

Figure 25. Import System File

5. The default setting is that all of the devices are selected but none of the parameters are selected. Check the box in the Import column for each device.
6. Click Check All to review all stored parameters.
7. Click **Import**.
8. Review the messages to make sure each device program is correctly imported. Imported *System* files contain an NVM store operation for each device by default. They need no separate NVM store command.

![Figure 26. Check All Parameters](image1)

![Figure 27. System File Import Messages](image2)
3.1.5 Export CSV Script for Third Party Tools

The Fusion Digital Power Designer software also exports configuration data to a comma-separated text file (.csv). Third-party software or programming vendors usually require the .csv format because it is easy to adapt to existing software.

1. To export data from a single device, click **Click to Configure Device** from the **System View**.
2. From the **File** menu, select **Export...**

![Device File Export](image)

**Figure 28. Device File Export**

3. From the **Device Export** page, click **PMBus Programmer Script** tab.
4. Use the settings shown in **Figure 29** for most situations. Third-party software sometimes has other requirements.
5. After you complete the settings, click Export PMBus Programmer Script.

6. The system generates a text file, and saves it to the path you select as the output folder.

3.1.6 Compare Two Project Files

This procedure applies to Project files created in Fusion Digital Power Designer 7.0 and later. This software compares Project files only. It does not compare Fusion Manufacturing scripts.

1. From the System View, click on a device name, and click Configure Device.

2. From the Tools menu, select Device/Project Configuration Compare
3. Select two or more Project files to compare.

![Figure 31. Compare Project Files](image1)

4. The Results window shows the differences between the commands in a column for each device.

![Figure 32. Project File Compare](image2)

3.1.7 Build a System File from Existing Project Files

New projects often share components with previous projects. With the Fusion Digital Power Designer software, designers can assemble a System (.tifsp) file using controller devices from existing Project files or System files. Individual projects must not be modified offline. However you can safely assemble existing Project files into a System file when the software operates in offline mode.

2. Open an existing System file.
3. From the System View, select Build System.
4. From the Define System window, select **Modify an existing system**.

5. Click **Next**.

6. The software displays the selected Project file names, the components and the addresses.

7. Click **Remove** to delete a device if needed.
8. To add a Project file, click **Select File**.
10. Update the PMBus address if necessary by clicking in the **Selected Addresses** cell.
11. Repeat steps 8 through 10 to add more Project files to the system.
12. Click **Finish**.

**Figure 35. Existing Project File Devices**
Figure 36. Add a Project File to a System File

3.2 Fusion Manufacturing Tool

3.2.1 Import a System File

Use the Fusion Manufacturing Tool in mass-production environments to import a System file (.tifsp) to an online board.

To download the Fusion Manufacturing Tool, click here: http://www.ti.com/tool/FUSION_MFR_GUI.

1. Build a Fusion System File (.tifsp) using Fusion Digital Power Designer
2. Apply power to the target board
3. Connect the USB-to-GPIO interface adapter
4. Start the Fusion Manufacturing Tool
5. Click the Load Script tab.
6. Click Browse to select a .tifsp file.
7. After the software loads the System file, it shows a list of available devices.
8. Review this list to make sure the correct System files are selected.
9. Click **Load Script**.

**Figure 37. Browse for System File**

**Figure 38. Load the Script**
10. Click **Scan** to ensure that the USB-to-GPIO interface adapter recognizes each device in the **System** file.

11. Click **Start** to upload the file to the target board.

![Digital Power Manufacturing Tool](image)

Figure 39. Scan and Start

12. The **Result Summary** dialog box appears. Click **OK**.

13. Disconnect power from the target board.

14. Repeat from step 10 for all remaining boards.
15. **3.3 TI Programming Board**

TI can provide a limited number of socketed programming boards for engineering and pre-production programming use. The programming board allows fast programming of prototyping samples or small production quantities. Boards are available for the unique package and pinout combinations that are supported by TI VR13 controllers. Request a board from your local field representative or sales representative.

This section describes the various connectors and components of the TI socketed programming board, and how to install devices properly to the socket.
3.3.1 Board and Connector Description

1. First 40-pin socket. Place DUT #1 in this socket, with pin 1 in the corner marked with a yellow star symbol.
2. 10-pin keyed connector for TI USB-to-GPIO adapter.
3. 2-pin connector (J2) for external 3.3V power supply
4. 3-position switch (S1). Determines whether the 3.3V power supply is sourced from external connector (J2):
   - Left position: sources 3.3-V power supply from PMBus adapter
   - Middle position: disconnected 3.3-V power
   - Right position: sources 3.3-V power supply from J2
5. 2-position switch (test mode selector). Switches between manual power-on and power-off (using S 2), or automatic control.
   - Left position. Automatic control. PMBus CNTL pin controls 3.3-V power applied to DUT #1 and DUT #2.
   - Right position. Manual control. Switch S2 controls 3.3-V power applied to DUT #1 and DUT #2.
6. Multiple board male connector (J1). Use J1 and J7 to mate multiple programming boards in series.
7. 2-position switch (S2). Toggles power applied to the socketed devices, when manual power control is selected using the test mode selector switch.
   - Up position: power is applied to DUTs (only in Manual mode).
   - Down position: Power is not applied to DUTs (only in Manual mode).
8. Second 40-pin socket. Place DUT #2 in this socket, with pin 1 in the corner marked with a yellow star.
symbol.

9. VREF2_ON. LED illuminates when DUT#2 successfully powers up (VREF voltage increased to approximately 1.7 V)

10. Address selection for DUT#2. Changing the jumper position according to the table printed on the silkscreen of the board changes the PMBus address that DUT#2 responds to.

11. Multiple board female connector (J7). Use J1 and J7 to mate multiple programming boards in series.

12. VREF1_ON. LED illuminates when DUT#2 successfully powers up (VREF voltage increased to approximately 1.7 V)

3.3.2 Placing devices in the 40-pin socket

1. Use any of these methods to make sure that power is not applied to the sockets before placing or replacing devices into this socket.
   • Move S1 to the middle position, so that neither the PMBus adaptor nor the J2 connector supplies power
   • Remove the power supply to J2 when S1 is in the right position.
   • Remove the PMBus adaptor connection when S1 is in the left position.
   • Switch S2 to the OFF position when the board operates in Manual mode.
   • Pull the PMBus CNTL pin low when the board operated in Automatic control mode.

2. Properly insert the device to match the Pin 1 marking on the board.

3. Close and latch the socket lid firmly before applying power to the device.

4. Make sure that both VREF_ON LEDs illuminate before you continue NVM programming.
IMPORTANT NOTICE FOR TI DESIGN INFORMATION AND RESOURCES

Texas Instruments Incorporated ("TI") technical, application or other design advice, services or information, including, but not limited to, reference designs and materials relating to evaluation modules, (collectively, "TI Resources") are intended to assist designers who are developing applications that incorporate TI products; by downloading, accessing or using any particular TI Resource in any way, you (individually or, if you are acting on behalf of a company, your company) agree to use it solely for this purpose and subject to the terms of this Notice.

TI's provision of TI Resources does not expand or otherwise alter TI's applicable published warranties or warranty disclaimers for TI products, and no additional obligations or liabilities arise from TI providing such TI Resources. TI reserves the right to make corrections, enhancements, improvements and other changes to its TI Resources.

You understand and agree that you remain responsible for using your independent analysis, evaluation and judgment in designing your applications and that you have full and exclusive responsibility to assure the safety of your applications and compliance of your applications (and of all TI products used in or for your applications) with all applicable regulations, laws and other applicable requirements. You represent that, with respect to your applications, you have all the necessary expertise to create and implement safeguards that (1) anticipate dangerous consequences of failures, (2) monitor failures and their consequences, and (3) lessen the likelihood of failures that might cause harm and take appropriate actions. You agree that prior to using or distributing any applications that include TI products, you will thoroughly test such applications and the functionality of such TI products as used in such applications. TI has not conducted any testing other than that specifically described in the published documentation for a particular TI Resource.

You are authorized to use, copy and modify any individual TI Resource only in connection with the development of applications that include the TI product(s) identified in such TI Resource. NO OTHER LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE TO ANY OTHER TI INTELLECTUAL PROPERTY RIGHT. AND NO LICENSE TO ANY TECHNOLOGY OR INTELLECTUAL PROPERTY RIGHT OF TI OR ANY THIRD PARTY IS GRANTED HEREIN, including but not limited to any patent right, copyright, mask work right, or other intellectual property right relating to any combination, machine, or process in which TI products or services are used. Information regarding or referencing third-party products or services does not constitute a license to use such products or services, or a warranty or endorsement thereof. Use of TI Resources may require a license from a third party under the patents or other intellectual property of the third party, or a license from TI under the patents or other intellectual property of TI.

TI RESOURCES ARE PROVIDED "AS IS" AND WITH ALL FAULTS. TI DISCLAIMS ALL OTHER WARRANTIES OR REPRESENTATIONS, EXPRESS OR IMPLIED, REGARDING TI RESOURCES OR USE THEREOF, INCLUDING BUT NOT LIMITED TO ACCURACY OR COMPLETENESS, TITLE, ANY EPIDEMIC FAILURE WARRANTY AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL PROPERTY RIGHTS.

TI SHALL NOT BE LIABLE FOR AND SHALL NOT DEFEND OR INDEMNIFY YOU AGAINST ANY CLAIM, INCLUDING BUT NOT LIMITED TO ANY INFRINGEMENT CLAIM THAT RELATES TO OR IS BASED ON ANY COMBINATION OF PRODUCTS EVEN IF DESCRIBED IN TI RESOURCES OR OTHERWISE. IN NO EVENT SHALL TI BE LIABLE FOR ANY ACTUAL, DIRECT, SPECIAL, COLLATERAL, INDIRECT, PUNITIVE, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF TI RESOURCES OR USE THEREOF, AND REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

You agree to fully indemnify TI and its representatives against any damages, costs, losses, and/or liabilities arising out of your non-compliance with the terms and provisions of this Notice.

This Notice applies to TI Resources. Additional terms apply to the use and purchase of certain types of materials, TI products and services. These include, without limitation, TI's standard terms for semiconductor products (http://www.ti.com/sc/docs/stdterms.htm), evaluation modules, and samples (http://www.ti.com/sc/docs/sampterms.htm).

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2018, Texas Instruments Incorporated